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When reading this manual, you will find references to other Stata manuals. For example,
 [U] 26 Overview of Stata estimation commands
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About this manual


This manual discusses Stata for WindowsR. Stata for MacR users should see Getting Started
 with Stata for Mac; Stata for UnixR users should see Getting Started with Stata for Unix. This
 manual is intended both for people who are completely new to Stata and for experienced Stata users
 new to Stata for Windows. Previous Stata users will also find it helpful as a tutorial on some new
 features in Stata for Windows.


Following the numbered chapters are three appendixes with information specific to Stata for
 Windows.


We provide several types of technical support to registered Stata users. [GSW] 4 Getting help
 describes the resources available to help you learn about Stata’s commands and features. One of these
 resources is the Stata website (http://www.stata.com), where you will find answers to frequently asked
 questions (FAQs) as well as other useful information. If you still have questions after looking at the
 Stata website and the other resources described in[GSW] 19 Updating and extending Stata—Internet
 functionality, you can contact us as described in[U] 3.8 Technical support.



Using this manual


The new user will get the most out of this book by treating it as an exercise book, working through
 each example at the computer. The material builds, so material from earlier chapters will often be
 used in later chapters. Bear in mind that Stata is a rich and deep statistical package—just as statistics
 itself is rich and deep. The time spent working the examples will be repaid with dividends when
 doing true statistical analyses.


The experienced user may still have something to learn from this manual despite its name. We
 suggest looking through the chapters to see if there is anything new or forgotten.


v
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1 Introducing Stata—sample session



Introducing Stata


This chapter will run through a sample work session, introducing you to a few of the basic tasks
 that can be done in Stata, such as opening a dataset, investigating the contents of the dataset, using
 some descriptive statistics, making some graphs, and doing a simple regression analysis. As you
 would expect, we will only brush the surface of many of these topics. This approach should give you
 a sample of what Stata can do and how Stata works. There will be brief explanations along the way,
 with references to chapters later in this book as well as to the system help and other Stata manuals.


We will run through the session by using both menus and dialogs and Stata’s commands so that you
 can become familiar with them both.If you see that your menus and dialogs are not in English, we
 recommend that you (temporarily) change the locale used by Stata to English, so that you can work
 along with the examples. See[P]set locale uifor how to do this.


Take a seat at your computer, put on some good music, and work along with the book.



Sample session


The dataset that we will use for this session is a set of data about vintage 1978 automobiles sold
 in the United States.


To follow along by pointing and clicking, note that the menu items are given by Menu > Menu
 item > Submenu item > etc. To follow along by using the Command window, type the commands
 that follow a dot (.) in the boxed listings below into the small window labeled Command. When
 there is something to note about the structure of a command, it will be pointed out as a “Syntax
 note”.


Start by loading theauto dataset, which is included with Stata. To use the menus,
 1. Select File > Example datasets....


2. Click onExample datasets installed with Stata.


3. Click onuseforauto.dta.


The result of this command is fourfold:


• The following output appears in the large Results window:


 


. sysuse auto


(1978 Automobile Data)


 


The output consists of a command and its result. The command, sysuse auto.dta, is bold
 and follows the dot (.). The result, (1978 Automobile Data), is in the standard face here
 and is a brief description of the dataset.


Note: If a command intrigues you, you can typehelpcommandnamein the Command window
 to find help. If you want to explore at any time, Help > Search... can be informative.


• The same command, sysuse auto.dta, appears in the tall Review window to the left. The
 Review window keeps track of all commands Stata has run, successful and unsuccessful. The
 commands can then easily be rerun. See[GSW] 2 The Stata user interfacefor more information.


1
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• A series of variables appears in the small Variables window to the upper right.


• Some information aboutmake, the first variable in the dataset, appears in the small Properties
 window to the lower right.


You could have opened the dataset by typingsysuse autoin the Command window and pressing
 Enter. Try this now.sysuseis a command that loads (uses) example (system) datasets. As you will
 see during this session, Stata commands are often simple enough that it is faster to use them directly.


This will be especially true once you become familiar with the commands you use the most in your
 daily use of Stata.


Syntax note: In the above example, sysuseis the Stata command, whereasauto is the name of
 a Stata data file.



Simple data management


We can get a quick glimpse at the data by browsing them in the Data Editor. This can be done
 by clicking on theData Editor (Browse) button, , or by selectingData > Data Editor > Data
 Editor (Browse)from the menus or by typing the commandbrowse.


Syntax note: Here the command isbrowseand there are no other arguments.


When the Data Editor opens, you can see that Stata regards the data as one rectangular table. This
 is true for all Stata datasets. The columns representvariables, whereas the rows representobservations.


The variables have somewhat descriptive names, whereas the observations are numbered.


The data are displayed in multiple colors—at first glance, it appears that the variables listed in black
are numeric, whereas those that are in colors are text. This is worth investigating. Click on a cell
under themakevariable: the input box at the top displays the make of the car. Scroll to the right until
you see theforeign variable. Click on one of its cells. Although the cell may display “Domestic”,
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 the input box displays a 0. This shows that Stata can store categorical data as numbers but display
 human-readable text. This is done by what Stata callsvalue labels. Finally, under therep78variable,
 which looks to be numeric, there are some cells containing just a dot (.). The dots correspond to
 missing values.


Looking at the data in this fashion, though comfortable, lends little information about the dataset.


It would be useful for us to get more details about what the data are and how the data are stored.


Close the Data Editor by clicking on its close button.


We can see the structure of the dataset by describing its contents. This can be done either by
 going toData > Describe data > Describe data in memory or in a filein the menus and clicking
 on OKor by typing describe in the Command window and pressing Enter. Regardless of which
 method you choose, you will get the same result:


 


. describe


Contains data from C:\Program Files\Stata14/ado/base/a/auto.dta


obs: 74 1978 Automobile Data


vars: 12 13 Apr 2014 17:45


size: 3,182 (_dta has notes)


storage display value


variable name type format label variable label


make str18 %-18s Make and Model


price int %8.0gc Price


mpg int %8.0g Mileage (mpg)


rep78 int %8.0g Repair Record 1978


headroom float %6.1f Headroom (in.)


trunk int %8.0g Trunk space (cu. ft.)


weight int %8.0gc Weight (lbs.)


length int %8.0g Length (in.)


turn int %8.0g Turn Circle (ft.)


displacement int %8.0g Displacement (cu. in.)


gear_ratio float %6.2f Gear Ratio


foreign byte %8.0g origin Car type


Sorted by: foreign


 


If your listing stops short, and you see a blue more at the base of the Results window, pressing
 the Spacebar or clicking on the blue more itself will allow the command to be completed.


At the top of the listing, some information is given about the dataset, such as where it is stored on
 disk, how much memory it occupies, and when the data were last saved. The bold1978 Automobile
 Datais the short description that appeared when the dataset was opened and is referred to as adata
 label by Stata. The phrase _dta has notesinforms us that there are notes attached to the dataset.


We can see what notes there are by typingnotesin the Command window:


 


. notes
 _dta:


1. from Consumer Reports with permission


 


Here we see a short note about the source of the data.
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Looking back at the listing from describe, we can see that Stata keeps track of more than just
 the raw data. Each variable has the following:


• Avariable name, which is what you call the variable when communicating with Stata. Variable
 names are one type of Stata name. See[U] 11.3 Naming conventions.


• A storage type, which is the way Stata stores its data. For our purposes, it is enough to know
 that types like, say, str# are string, or text, variables, whereas all others in this dataset are
 numeric. While there are none in this dataset, Stata also allows arbitrarily long strings, or
 strLs. strLs can even contain binary information. See[U] 12.4 Strings.


• A display format, which controls how Stata displays the data in tables. See[U] 12.5 Formats:


Controlling how data are displayed.


• Avalue label (possibly). This is the mechanism that allows Stata to store numerical data while
 displaying text. See [GSW] 9 Labeling data and[U] 12.6.3 Value labels.


• A variable label, which is what you call the variable when communicating with other people.


Stata uses the variable label when making tables, as we will see.


A dataset is far more than simply the data it contains. It is also information that makes the data
 usable by someone other than the original creator.


Although describing the data tells us something about the structure of the data, it says little about
 the data themselves. The data can be summarized by clicking on Statistics > Summaries, tables,
 and tests > Summary and descriptive statistics > Summary statistics and clicking on the OK
 button. You could also typesummarize in the Command window and press Enter. The result is a
 table containing summary statistics about all the variables in the dataset:


 


. summarize


Variable Obs Mean Std. Dev. Min Max


make 0


price 74 6165.257 2949.496 3291 15906


mpg 74 21.2973 5.785503 12 41


rep78 69 3.405797 .9899323 1 5


headroom 74 2.993243 .8459948 1.5 5


trunk 74 13.75676 4.277404 5 23


weight 74 3019.459 777.1936 1760 4840


length 74 187.9324 22.26634 142 233


turn 74 39.64865 4.399354 31 51


displacement 74 197.2973 91.83722 79 425


gear_ratio 74 3.014865 .4562871 2.19 3.89


foreign 74 .2972973 .4601885 0 1


 


From this simple summary, we can learn a bit about the data. First of all, the prices are nothing like
 today’s car prices—of course, these cars are now antiques. We can see that the gas mileages are not
 particularly good. Automobile aficionados can get a feel for other esoteric characteristics.


There are two other important items here:


• The make variable is listed as having no observations. It really has no numerical observations
 because it is a string (text) variable.


• Therep78variable has five fewer observations than the other numerical variables. This implies
 thatrep78 has five missing values.


Although we could use the summarizeanddescribecommands to get a bird’s eye view of the
dataset, Stata has a command that gives a good in-depth description of the structure, contents, and
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 values of the variables: the codebook command. Either type codebook in the Command window
 and pressEnteror navigate the menus toData > Describe data > Describe data contents (codebook)
 and click onOK. We get a large amount of output that is worth investigating. In fact, we get more
 output than can fit on one screen, as can be seen by the blue more at the bottom of the Results
 window. Press the Spacebar a few times to get all the output to scroll past. (For more about more ,
 seeMore in[GSW]10 Listing data and basic command syntax.) Look over the output to see that
 much can be learned from this simple command. You can scroll back in the Results window to see
 earlier results, if need be. We will focus on the output formake,rep78, andforeign.


To start our investigation, we would like to run the codebook command on just one variable,
 say,make. We can do this, as usual, with menus or the command line. To get thecodebookoutput
 formake with the menus, start by navigating to Data > Describe data > Describe data contents
 (codebook). When the dialog appears, there are multiple ways to tell Stata to consider only themake
 variable:


• We could typemake into theVariables field.


• The Variables field is a combo-box control that accepts variable names. Clicking on the drop
 triangle to the right of theVariablesfield displays a list of the variables from the current dataset.


Selecting a variable from the list will, in this case, enter the variable name into the edit field.


A much easier solution is to typecodebook make in the Command window and then press Enter.


The result is informative:


 


. codebook make


make Make and Model


type: string (str18), but longest is str17
 unique values: 74 missing "": 0/74


examples: "Cad. Deville"


"Dodge Magnum"


"Merc. XR-7"


"Pont. Catalina"


warning: variable has embedded blanks


 


The first line of the output tells us the variable name (make) and the variable label (Make and Model).


The variable is stored as a string (which is another way of saying “text”) with a maximum length of
 18 characters, though a size of only 17 characters would be enough. All the values are unique, so
 if need be,make could be used as an identifier for the observations—something that is often useful
 when putting together data from multiple sources or when trying to weed out errors from the dataset.


There are no missing values, but there are blanks within the makes. This latter fact could be useful
 if we were expectingmake to be a one-word string variable.


Syntax note: Telling thecodebookcommand to run on themake variable is an example of using
 avarlist in Stata’s syntax.


Looking at the foreign variable can teach us about value labels. We would like to look at the
codebook output for this variable, and on the basis of our latest experience, it would be easy to type
codebook foreign into the Command window (from here on, we will not explicitly say to press
theEnter key) to get the following output:
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. codebook foreign


foreign Car type


type: numeric (byte)
 label: origin


range: [0,1] units: 1


unique values: 2 missing .: 0/74


tabulation: Freq. Numeric Label


52 0 Domestic


22 1 Foreign


 


We can glean thatforeignis an indicator variable because its only values are 0 and 1. The variable
 has a value label that displays Domestic instead of 0 and Foreign instead of 1. There are two
 advantages of storing the data in this form:


• Storing the variable as a byte takes less memory because each observation uses 1 byte instead of the
 8 bytes needed to store “Domestic”. This is important in large datasets. See[U] 12.2.2 Numeric
 storage types.


• As an indicator variable, it is easy to incorporate into statistical models. See [U] 25 Working
 with categorical data and factor variables.


Finally, we can learn a little about a poorly labeled variable with missing values by looking at the
 rep78variable. Typing codebook rep78into the Command window yields


 


. codebook rep78


rep78 Repair Record 1978


type: numeric (int)


range: [1,5] units: 1


unique values: 5 missing .: 5/74


tabulation: Freq. Value
 2 18 2
 30 318 4
 11 55 .


 


rep78appears to be a categorical variable, but because of lack of documentation, we do not know
what the numbers mean. (To see how we would label the values, seeChanging datain[GSW]6 Using
the Data Editorand see [GSW] 9 Labeling data.) This variable has five missing values, meaning
that there are five observations for which the repair record is not recorded. We could use the Data
Editor to investigate these five observations, but we will do this by using the Command window only
because doing so is much simpler. If you recall, the command brought up by clicking on theData
Editor (Browse)button was browse. We would like to browse only those observations for which
rep78is missing, so we could type
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. browse if missing(rep78)


 


From this, we see that the. entries are indeed missing values. The.is the default numerical missing
 value; Stata also allows.a, . . ., .zas user missing values, but we do not have any in our dataset.


See[U] 12.2.1 Missing values. Close the Data Editor after you are satisfied with this statement.


Syntax note: Using theifqualifier above is what allowed us to look at a subset of the observations.


Looking through the data lends no clues about why these particular data are missing. We decide
 to check the source of the data to see if the missing values were originally missing or if they were
 omitted in error. Listing the makes of the cars whose repair records are missing will be all we need
 because we saw earlier that the values ofmake are unique. This can be done with the menus and a
 dialog:


1. Select Data > Describe data > List data.


2. Click on the drop triangle to the right of the Variables field to show the variable names.


3. Click onmake to enter it into theVariablesfield.


4. Click on the by/if/in tab in the dialog.


5. Type missing(rep78)into theIf: (expression) box.


6. Click onSubmit. Stata executes the proper command but the dialog remains open. Submitis
 useful when experimenting, exploring, or building complex commands. We will primarily use
 Submit in the examples. You may click on OK in its place if you like, and it will close the
 dialog box.


The same ends could be achieved by typing list make if missing(rep78) in the Command
 window. The latter is easier once you know that the commandlistis used for listing observations.


In any case, here is the output:
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. list make if missing(rep78)
 make


3. AMC Spirit
 7. Buick Opel
 45. Plym. Sapporo
 51. Pont. Phoenix
 64. Peugeot 604


 


At this point we should find the original reference to see if the data were truly missing or if they
 could be resurrected. See[GSW] 10 Listing data and basic command syntaxfor more information
 about all that can be done with thelistcommand.


Syntax note: This command uses two new concepts for Stata commands—theifqualifier and the
 missing()function. Theifqualifier restricts the observations on which the command runs to only
 those observations for which the expression is true. See[U] 11.1.3 if exp. Themissing()function
 tests each observation to see if it contains a missing value. See[FN]Programming functions.


Now that we have a good idea about the underlying dataset, we can investigate the data themselves.



Descriptive statistics


We saw above that thesummarizecommand gave brief summary statistics about all the variables.


Suppose now that we became interested in the prices while summarizing the data because they seemed
 fantastically low (it was 1978, after all). To get an in-depth look at thepricevariable, we can use
 the menus and a dialog:


1. Select Statistics > Summaries, tables, and tests > Summary and descriptive statistics >


Summary statistics.


2. Enter or select pricein theVariables field.


3. Select Display additional statistics.


4. Click onSubmit.


Syntax note: As can be seen from the Results window, typingsummarize price, detail will get
the same result. The portion after the comma containsoptions for Stata commands; hence, detail
is an example of an option.
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. summarize price, detail


Price
 Percentiles Smallest


1% 3291 3291


5% 3748 3299


10% 3895 3667 Obs 74


25% 4195 3748 Sum of Wgt. 74


50% 5006.5 Mean 6165.257


Largest Std. Dev. 2949.496


75% 6342 13466


90% 11385 13594 Variance 8699526


95% 13466 14500 Skewness 1.653434


99% 15906 15906 Kurtosis 4.819188


 


From the output, we can see that the median price of the cars in the dataset is only $5,006.50! We can
 also see that the four most expensive cars are all priced between $13,400 and $16,000. If we wished
 to browse the most expensive cars (and gain some experience with features of the Data Editor), we
 could start by clicking on theData Editor (Browse)button, . Once the Data Editor is open, we
 can click on theFilter observationsbutton, , to bring up theFilter observationsdialog. We can
 look at the expensive cars by puttingprice > 13000 in theFilter by expressionfield:


Pressing the Apply filterbutton filters the data, and we can see that the expensive cars are two
Cadillacs and two Lincolns, which were not designed for gas mileage:
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We now decide to turn our attention to foreign cars and repairs because as we glanced through the
 data, it appeared that the foreign cars had better repair records. (We do not know exactly what the
 categories 1, 2, 3, 4, and 5 mean, but we know the Chevy Monza was known for breaking down.)
 Let’s start by looking at the proportion of foreign cars in the dataset along with the proportion of
 cars with each type of repair record. We can do this with one-way tables. The table forforeign
 cars can be done with menus and a dialog starting withStatistics > Summaries, tables, and tests


> Frequency tables > One-way tableand then choosing the variable foreign in the Categorical
 variablefield. Clicking onSubmityields


 


. tabulate foreign


Car type Freq. Percent Cum.


Domestic 52 70.27 70.27


Foreign 22 29.73 100.00


Total 74 100.00


 


We see that roughly 70% of the cars in the dataset are domestic, whereas 30% are foreign. The value
 labels are used to make the table so that the output is nicely readable.


Syntax note: We also see that this one-way table could be made by using thetabulatecommand
 together with one variable, foreign. Making a one-way table for the repair records is simple—it
 will be simpler if done with the Command window. Typingtabulate rep78yields


 


. tabulate rep78
 Repair


Record 1978 Freq. Percent Cum.


1 2 2.90 2.90


2 8 11.59 14.49


3 30 43.48 57.97


4 18 26.09 84.06


5 11 15.94 100.00


Total 69 100.00
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 We can see that most cars have repair records of 3 and above, though the lack of value labels
 makes us unsure what a “3” means. Take our word for it that 1 means a poor repair record and 5
 means a good repair record. The five missing values are indirectly evident because the total number
 of observations listed is 69 rather than 74.


These two one-way tables do not help us compare the repair records of foreign and domestic cars.


A two-way table would help greatly, which we can get by using the menus and a dialog:


1. Select Statistics > Summaries, tables, and tests > Frequency tables > Two-way table with
 measures of association.


2. Choose rep78as theRow variable.


3. Choose foreignas theColumn variable.


4. It would be nice to have the percentages within theforeignvariable, so check theWithin-row
 relative frequenciescheckbox.


5. Click onSubmit.


Here is the resulting output:


 


. tabulate rep78 foreign, row
 Key


frequency
 row percentage


Repair


Record Car type


1978 Domestic Foreign Total


1 2 0 2


100.00 0.00 100.00


2 8 0 8


100.00 0.00 100.00


3 27 3 30


90.00 10.00 100.00


4 9 9 18


50.00 50.00 100.00


5 2 9 11


18.18 81.82 100.00


Total 48 21 69


69.57 30.43 100.00


 


The output indicates that foreign cars are generally much better than domestic cars when it comes
 to repairs. If you like, you could repeat the previous dialog and try some of the hypothesis tests
 available from the dialog. We will abstain.


Syntax note: We see that typing the commandtabulate rep78 foreign, rowwould have given
 us the same table. Thus usingtabulatewith two variables yields a two-way table. It makes sense
 thatrowis an option—we went out of our way to check it in the dialog. Using therowoption allows
 us to change the behavior of thetabulatecommand from its default.


Continuing our exploratory tour of the data, we would like to compare gas mileages between
foreign and domestic cars, starting by looking at the summary statistics for each group by itself. A
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direct way to do this would be to useifqualifiers to summarizempgfor each of the two values of
 foreignseparately:


 


. summarize mpg if foreign==0


Variable Obs Mean Std. Dev. Min Max


mpg 52 19.82692 4.743297 12 34


. summarize mpg if foreign==1


Variable Obs Mean Std. Dev. Min Max


mpg 22 24.77273 6.611187 14 41


 


It appears that foreign cars get somewhat better gas mileage—we will test this soon.


Syntax note: We needed to use a double equal sign (==) for testing equality. The double equal
 sign could be familiar to you if you have programmed before. If it is unfamiliar, be aware that it is a
 common source of errors when initially using Stata. Thinking of equality as “exactly equal” can cut
 down on typing errors.


There are two other methods that we could have used to produce these summary statistics. These
 methods are worth knowing because they are less error-prone. The first method duplicates the concept
 of what we just did by exploiting Stata’s ability to run a command on each of a series of nonoverlapping
 subsets of the dataset. To use the menus and a dialog, do the following:


1. Select Statistics > Summaries, tables, and tests > Summary and descriptive statistics >


Summary statistics and click on theReset button, .
 2. Select mpgin theVariables field.


3. Select theStandard displayoption (if it is not already selected).


4. Click on the by/if/in tab.


5. Check the Repeat command by groupscheckbox.


6. Select or type foreignin the Variables that define groupsfield.


7. Submit the command.


You can see that the results match those from above. They have a better appearance than the two
 commands above because the value labelsDomesticandForeignare used rather than the numerical
 values. The method is more appealing because the results were produced without needing to know
 the possible values of the grouping variable ahead of time.


 


. by foreign, sort: summarize mpg
 -> foreign = Domestic


Variable Obs Mean Std. Dev. Min Max


mpg 52 19.82692 4.743297 12 34


-> foreign = Foreign


Variable Obs Mean Std. Dev. Min Max


mpg 22 24.77273 6.611187 14 41


 


Syntax note: There is something different about the equivalent command that appears above: it contains
a prefix command called a by prefix. The by prefix has its own option, namely, sort, to ensure
that like members are adjacent to each other before being summarized. Theby prefix command is
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 important for understanding data manipulation and working with subpopulations within Stata. Make
 good note of this example, and consult[U] 11.1.2 by varlist:and[U] 27.2 The by constructfor more
 information. Stata has other prefix commands for specialized treatment of commands, as explained
 in[U] 11.1.10 Prefix commands.


The third method for tabulating the differences in gas mileage across the cars’ origins involves
 thinking about the structure of desired output. We need a one-way table of automobile types (foreign
 versus domestic) within which we see information about gas mileages. Looking through the menus
 yields the menu itemStatistics > Summaries, tables, and tests > Other tables > Table of means,
 std. dev., and frequencies. Selecting this, enteringforeignforVariable 1andmpgfor theSummarize
 variable, and submitting the command yields a nice table:


 


. tabulate foreign, summarize(mpg)


Summary of Mileage (mpg)


Car type Mean Std. Dev. Freq.


Domestic 19.826923 4.7432972 52
 Foreign 24.772727 6.6111869 22
 Total 21.297297 5.7855032 74


 


The equivalent command is evidentlytabulate foreign, summarize(mpg).


Syntax note: This is a one-way table, sotabulateuses one variable. The variable being summarized
 is passed to thetabulatecommand with an option. Though we will not do it here, thesummarize()
 option can also be used with two-way tables.



A simple hypothesis test


We would like to run a hypothesis test for the difference in the mean gas mileages. Under the menus,
 Statistics > Summaries, tables, and tests > Classical tests of hypotheses > t test (mean-comparison
 test)leads to the proper dialog. Select theTwo-sample using groupsradio button, entermpgfor the
 Variable nameandforeignfor the Group variable name, andSubmitthe dialog. The results are


 


. ttest mpg, by(foreign)


Two-sample t test with equal variances


Group Obs Mean Std. Err. Std. Dev. [95% Conf. Interval]


Domestic 52 19.82692 .657777 4.743297 18.50638 21.14747
 Foreign 22 24.77273 1.40951 6.611187 21.84149 27.70396
 combined 74 21.2973 .6725511 5.785503 19.9569 22.63769


diff -4.945804 1.362162 -7.661225 -2.230384


diff = mean(Domestic) - mean(Foreign) t = -3.6308


Ho: diff = 0 degrees of freedom = 72


Ha: diff < 0 Ha: diff != 0 Ha: diff > 0


Pr(T < t) = 0.0003 Pr(|T| > |t|) = 0.0005 Pr(T > t) = 0.9997


 


From this, we could conclude that the mean gas mileage for foreign cars is different from that of
domestic cars (though we really ought to have wanted to test this before snooping through the data).
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We can also conclude that the command,ttest mpg, by(foreign), is easy enough to remember.


Feel free to experiment with unequal variances, various approximations to the number of degrees of
 freedom, and the like.


Syntax note: The by() option used here is not the same as theby prefix command used earlier.


Although it has a similar conceptual meaning, its usage is different because it is a particular option
 for thettest command.



Descriptive statistics—correlation matrices


We now change our focus from exploring categorical relationships to exploring numerical relation-
 ships: we would like to know if there is a correlation between miles per gallon and weight. We select
 Statistics > Summaries, tables, and tests > Summary and descriptive statistics > Correlations
 and covariancesin the menus. Entering mpgandweight, either by clicking or by typing, and then
 submitting the command yields


 


. correlate mpg weight
 (obs=74)


mpg weight
 mpg 1.0000


weight -0.8072 1.0000


 


The equivalent command for this is natural:correlate mpg weight. There is a negative correlation,
 which is not surprising because heavier cars should be harder to push about.


We could see how the correlation compares for foreign and domestic cars by using our knowledge
 of thebyprefix. We can reuse thecorrelate dialog or use the menus as before if the dialog is closed.


Click on theby/if/in tab, check the Repeat command by groupscheckbox, and enter the foreign
 variable to define the groups. As done on page12, a simpleby foreign, sort:prefix in front of
 our previous command would work, too:


 


. by foreign, sort: correlate mpg weight
 -> foreign = Domestic


(obs=52)


mpg weight
 mpg 1.0000


weight -0.8759 1.0000
 -> foreign = Foreign


(obs=22)


mpg weight
 mpg 1.0000


weight -0.6829 1.0000


 


We see from this that the correlation is not as strong among the foreign cars.


Syntax note: Although we used thecorrelatecommand to look at the correlation of two variables,
Stata can make correlation matrices for an arbitrary number of variables:
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. correlate mpg weight length turn displacement
 (obs=74)


mpg weight length turn displa~t


mpg 1.0000


weight -0.8072 1.0000


length -0.7958 0.9460 1.0000


turn -0.7192 0.8574 0.8643 1.0000


displacement -0.7056 0.8949 0.8351 0.7768 1.0000


 


This can be useful, for example, when investigating collinearity among predictor variables.



Graphing data


We have found several things in our investigations so far: We know that the average MPG of
 domestic and foreign cars differs. We have learned that domestic and foreign cars differ in other
 ways as well, such as in frequency-of-repair record. We found a negative correlation between MPG


and weight—as we would expect—but the correlation appears stronger for domestic cars.


We would now like to examine, with an eye toward modeling, the relationship between MPGand
 weight, starting with a graph. We can start with a scatterplot ofmpgagainstweight. The command
 for this is simple: scatter mpg weight. Using the menus requires a few steps because the graphs
 in Stata may be customized heavily.


1. Select Graphics > Twoway graph (scatter, line, etc.).


2. Click on the Create... button.


3. Select theBasic plots radio button (if it is not already selected).


4. Select Scatteras the basic plot type (if it is not already selected).


5. Select mpgas theY variableandweightas theX variable.


6. Click on the Submitbutton.


The Results window shows the command that was issued from the menu:


 


. twoway (scatter mpg weight)


 


The command issued when the dialog was submitted is a bit more complex than the command
suggested above. There is good reason for this: the more complex structure allows combining and
overlaying graphs, as we will soon see. In any case, the graph that appears is
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10203040Mileage (mpg)


2,000 3,000 4,000 5,000


Weight (lbs.)


We see the negative correlation in the graph, though the relationship appears to be nonlinear.


Note: When you draw a graph, the Graph window appears, probably covering up your Results
 window. Click on the main Stata window to get the Results window back on top. Want to see the
 graph again? Click on theGraph button, . See The Graph button in[GSW]14 Graphing data
 for more information about theGraph button.


We would now like to see how the different correlations for foreign and domestic cars are manifested
 in scatterplots. It would be nice to see a scatterplot for each type of car, along with a scatterplot for
 all the data.


Syntax note: Because we are looking at subgroups, this looks as if it is a job for the by prefix.


Let’s see if this is what we really should use.


Start as before:


1. Select Graphics > Twoway graph (scatter, line, etc.)from the menus.


2. If the Plot 1dialog is still visible, click on theAcceptbutton and skip to step 4.


3. Go through the process on the previous page to create the graph.


4. Click on the Bytab of the twoway - Twoway graphsdialog.


5. Check the Draw subgraphs for unique values of variablescheckbox.


6. Enter foreignin theVariables field.


7. Check the Add a graph with totals checkbox.


8. Click on the Submitbutton.
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 The command and the associated graph are


 


. twoway (scatter mpg weight), by(foreign, total)
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Graphs by Car type


The graphs show that the relationship is nonlinear for both types of cars.


Syntax note: To make the graphs for the combined subgroups, we ended up using aby()option,
 not a byprefix. If we had used a by prefix, separate graphs would have been generated instead of
 the combined graph created by theby() option.



Model fitting: Linear regression


After looking at the graphs, we would like to fit a regression model that predicts MPGfrom the
 weight and type of the car. From the graphs, we see that the relationship is nonlinear, so we will
 try modelingMPG as a quadratic in weight. Also from the graphs, we judge the relationship to be
 different for domestic and foreign cars. We will include an indicator (dummy) variable forforeign
 and evaluate afterward whether this adequately describes the difference. Thus we will fit the model


mpg=β0+β1weight+β2weight2+β3foreign+


foreign is already an indicator (0/1) variable, but we need to create the weight-squared variable.


This can be done with the menus, but here using the command line is simpler. Type


 


. generate wtsq = weight^2
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Now that we have all the variables we need, we can run a linear regression. We will use the
 menus and see that the command is also simple. To use the menus, selectStatistics > Linear models
 and related > Linear regression. In the resulting dialog, choose mpg as the Dependent variable
 andweight, wtsq, and foreign as the Independent variables.Submit the command. Here is the
 equivalent simpleregress command and the resulting analysis-of-variance table.


 


. regress mpg weight wtsq foreign


Source SS df MS Number of obs = 74


F(3, 70) = 52.25


Model 1689.15372 3 563.05124 Prob > F = 0.0000
 Residual 754.30574 70 10.7757963 R-squared = 0.6913
 Adj R-squared = 0.6781
 Total 2443.45946 73 33.4720474 Root MSE = 3.2827
 mpg Coef. Std. Err. t P>|t| [95% Conf. Interval]


weight -.0165729 .0039692 -4.18 0.000 -.0244892 -.0086567
 wtsq 1.59e-06 6.25e-07 2.55 0.013 3.45e-07 2.84e-06
 foreign -2.2035 1.059246 -2.08 0.041 -4.3161 -.0909002
 _cons 56.53884 6.197383 9.12 0.000 44.17855 68.89913


 


The results look encouraging, so we will plot the predicted values on top of the scatterplots for each
 of the types of cars. To do this, we need the predicted, or fitted, values. This can be done with
 the menus, but doing it in the Command window is simple enough. We will create a new variable,
 mpghat, to hold the predicted MPGfor each car. Type


 


. predict mpghat


(option xb assumed; fitted values)


 


The output from this command is simply a notification. Go over to the Variables window and scroll
 to the bottom to confirm that there is now an mpghat variable. If you were to try this command
 whenmpghatalready existed, Stata would refuse to overwrite your data:


 


. predict mpghat


variable mpghat already defined
 r(110);


 


The predict command, when used after a regression, is called a postestimation command. As
 specified, it creates a new variable calledmpghatequal to


−0.0165729weight+1.59×10−6wtsq−2.2035foreign+56.53884


For careful model fitting, there are several features available to you after estimation—one is
 calculating predicted values. Be sure to read[U] 20 Estimation and postestimation commands.


We can now graph the data and the predicted curve to evaluate separately the fit on the foreign
 and domestic data to determine if our shift parameter is adequate. We can draw both graphs together.


Using the menus and a dialog, do the following:


1. Select Graphics > Twoway graph (scatter, line, etc.)from the menus.


2. If there are any plots listed, click on the Resetbutton, , to clear the dialog box.
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 3. Create the graph for mpgversusweight:


a. Click on theCreate... button.


b. Be sure thatBasic plots andScatterare selected.


c. Select mpgas theY variableandweightas theX variable.


d. Click onAccept.


4. Create the graph showingmpghatversus weight
 a. Click on theCreate... button.


b. Select Basic plotsandLine.


c. Select mpghatas theY variable andweightas theX variable.


d. Check theSort on x variablebox. Doing so ensures that the lines connect from smallest
 to largest weightvalues, instead of the order in which the data happen to be.


e. Click onAccept.


5. Show two plots, one each for domestic and foreign cars, on the same graph:


a. Click on theBytab.


b. Check theDraw subgraphs for unique values of variablescheckbox.


c. Enter foreignin theVariables field.


6. Click on the Submitbutton.


Here are the resulting command and graph:


 


. twoway (scatter mpg weight) (line mpghat weight, sort), by(foreign)
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Here we can see the reason for enclosing the separatescatterandlinecommands in parentheses:


they can thereby be overlaid by submitting them together. The fit of the plots looks good and is cause
 for initial excitement. So much excitement, in fact, that we decide to print the graph and show it to
 an engineering friend. We print the graph, being careful to print the graph (and not all our results),
 by choosingFile > Print... from the Graph window menu bar.


When we show our graph to our engineering friend, she is concerned. “No,” she says. “It should
 take twice as much energy to move 2,000 pounds 1 mile compared with moving 1,000 pounds the
 same distance: therefore, it should consume twice as much gasoline. Miles per gallon is not quadratic
 in weight; gallons per mile is a linear function of weight. Don’t you remember any physics?”


We try out what she says. We need to generate an energy-per-distance variable and make a
 scatterplot. Here are the commands that we would need—note their similarity to commands issued
 earlier in the session. There is one new command, thelabel variablecommand, which allows us
 to give thegpm100m variable avariable label so that the graph is labeled nicely.


 


. generate gp100m = 100/mpg


. label variable gp100m "Gallons per 100 miles"


. twoway (scatter gp100m weight), by(foreign, total)
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 Sadly satisfied that the engineer is indeed correct, we rerun the regression:


 


. regress gp100m weight foreign


Source SS df MS Number of obs = 74


F(2, 71) = 113.97


Model 91.1761694 2 45.5880847 Prob > F = 0.0000
 Residual 28.4000913 71 .400001287 R-squared = 0.7625
 Adj R-squared = 0.7558
 Total 119.576261 73 1.63803097 Root MSE = .63246
 gp100m Coef. Std. Err. t P>|t| [95% Conf. Interval]


weight .0016254 .0001183 13.74 0.000 .0013896 .0018612
 foreign .6220535 .1997381 3.11 0.003 .2237871 1.02032
 _cons -.0734839 .4019932 -0.18 0.855 -.8750354 .7280677


 


We find that foreign cars had better gas mileage than domestic cars in 1978 because they were so
 light. According to our model, a foreign car with the same weight as a domestic car would use an
 additional 5/8 gallon (or 5 pints) of gasoline per 100 miles driven. With this conclusion, we are
 satisfied with our analysis.



Commands versus menus


In this chapter, you have seen that Stata can operate either with menu choices and dialogs or with
 the Command window. As you become more familiar with Stata, you will find that the Command
 window is typically much faster for oft-used commands, whereas the menus and dialogs are faster
 when building up complex commands, such as those that create graphs.


One of Stata’s great strengths is the consistency of itscommand syntax. Most of Stata’s commands
 share the following syntax, where square brackets mean that something is optional, and avarlistis a
 list of variables.


prefix:


command


varlist if in weight ,options
 Some general rules:


• Most commands accept prefix commands that modify their behavior; see [U] 11.1.10 Prefix
 commands for details. One of the common prefix commands isby.


• If an optionalvarlistis not specified, all the variables are used.


• if andinrestrict the observations on which the command is run.


• options modify what the command does.


• Each command’s syntax is found in the system help and the reference manuals.


• Stata’s command syntax includes more than we have shown you here, but this introduction
 should get you started. For more information, see[U] 11 Language syntaxandhelp language.


We saw examples using all the pieces of this except for theinqualifier and theweightclause. The
 syntax for all commands can be found in the system help along with examples—see[GSW] 4 Getting
 helpfor more information. The consistent syntax makes it straightforward to learn new commands
 and to read others’ commands when examining an analysis.


Here is an example of reading the syntax diagram that uses thesummarizecommand from earlier
 in this chapter. The syntax diagram forsummarizeis typical:


summarize


varlist if in weight ,options
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This means that


commandby itself is valid: summarize
 commandfollowed by avarlist


(variable list) is valid: summarize mpg


summarize mpg weight
 commandwithif(with or without


a varlist) is valid: summarize if mpg>20


summarize mpg weight if mpg>20
 and so on.


You can learn aboutsummarizein[R]summarize, or selectHelp > Stata command... and enter
 summarize, or typehelp summarize in the Command window.



Keeping track of your work


It would have been useful if we had made a log of what we did so that we could conveniently
 look back at interesting results or track any changes that were made. You will learn to do this in
 [GSW] 16 Saving and printing results by using logs. Your logs will contain commands and their
 output—another reason to learn command syntax is so that you can remember what you have done.


To make a log file that keeps track of everything appearing in the Results window, click on the
 Logbutton, which looks like a lab notebook, . Choose a place to store your log file, and give
 it a name, just as you would for any other document. The log file will save everything that appears
 in the Results window from the time you start a log file to the time you close it.



Conclusion


This chapter introduced you to Stata’s capabilities. You should now read and work through the
rest of this manual. Once you are done here, you can read theUser’s Guide.
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The windows


This chapter introduces the core of Stata’s interface: its main windows, its toolbar, its menus, and
 its dialogs.


The five main windows are the Review, Results, Command, Variables, and Properties windows.


Except for the Results window, each window has its name in its title bar. These five windows are
 typically in use the whole time Stata is open. There are other, more specialized windows such as the
 Viewer, Data Editor, Variables Manager, Do-file Editor, Graph, and Graph Editor windows—these
 are discussed later in this manual.


To open any window or to reveal a window hidden by other windows, select the window from
 theWindowmenu, or select the proper item from the toolbar. You can also use Ctrl+Tab to cycle
 through all open windows inside the main Stata window orAlt+Tabto cycle through all open windows
 (Stata and other) if you want to change windows from the keyboard. Many of Stata’s windows have
 functionality that can be accessed by clicking on the right mouse button (right-clicking) within the
 window. Right-clicking displays a contextual menu that, depending on the window, allows you to
 copy text, set the preferences for the window, or print the contents of the window. When you copy
 text or print, we recommend that you always right-click on the window rather than use the menu bar
 or toolbar so that you can be sure of where and what you are copying or printing.
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The toolbar


This is the toolbar:


The toolbar contains buttons that provide quick access to Stata’s more commonly used features.


If you forget what a button does, hold the mouse pointer over the button for a moment, and a tooltip
 will appear with a description of that button.


Buttons that include both an icon and an arrow display a menu if you click on the arrow. Here is
 an overview of the toolbar buttons and their functions:


Open opens a Stata dataset. Click on the button to open a dataset with the Open
 dialog.


Savesaves the Stata dataset currently in memory to disk.


Printdisplays a list of windows. Select a window name to print its contents.


Log begins a new log or closes, suspends, or resumes the current log. See
 [GSW] 16 Saving and printing results by using logs for an explanation of log
 files.


Vieweropens the Viewer or brings a Viewer to the front of all other windows. Click
 on the button to open a new Viewer. Click on the arrow to select a Viewer to bring
 to the front. See[GSW] 3 Using the Viewer for more information.


Graphbrings a Graph window to the front of all other windows. Click on the button
 to bring the Graph window to the front. Click on the arrow to select a Graph window
 to bring to the front. See The Graph buttonin [GSW]14 Graphing data for more
 information.


Do-file Editor opens the Do-file Editor or brings a Do-file Editor to the front of
 all other windows. Click on the button to open a new Do-file Editor. Click on the
 arrow to select a Do-file Editor to bring to the front. See[GSW] 13 Using the Do-file
 Editor—automating Statafor more information.


Data Editor (Edit)opens the Data Editor or brings the Data Editor to the front of
 the other Stata windows. See[GSW] 6 Using the Data Editorfor more information.


Data Editor (Browse)opens the Data Editor in browse mode. SeeBrowse modein
 [GSW]6 Using the Data Editor for more information.


Variables Manageropens the Variables Manager. See[GSW] 7 Using the Variables
 Managerfor more information.


Clear more conditiontells Stata to continue when it has paused in the middle
 of long output. See [GSW] 10 Listing data and basic command syntax for more
 information.


Breakstops the current task in Stata. See[GSW] 10 Listing data and basic command
syntaxfor more information.
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